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) Introduction

This document is the User Guide for PDF Customizer. It describes the extension
functionality and provides some tips for a quick start.

PDF Customizer is a powerful tool that allows you to create & customize beautiful PDF
documents with visual drag & drop interface. No more converting complex HTML code to

PDF, no time-consuming.

PDF Customizer is developed on a core builder based on which we’ve built all builder
extensions. The core builder includes elements and settings that all builder extensions have

in common. For details, please visit:

https://magezon.com/pub/media/productfile/magezon-core-builder-user guides.pdf

In this guide, we’ll focus on elements and settings that are specific to PDF Customizer.


https://www.magezon.com/magento-2-pdf-customizer.html
https://magezon.com/pub/media/productfile/magezon-core-builder-user_guides.pdf
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Il) Configuration

From the backend, navigate Stores > Configuration > Magezon Extensions > PDF
Customizer or Marketing > PDF Customizer > Settings

The interface will look like below:

T i 2admin v
Configuration Q  #D L i
Scope:  Default Config v (@) Save Config
GENERAL ¥ General Settings ©
CATALOG ~
Order ©
SECURITY v
Invoice ©
() MAGEZON EXTENSIONS ~
Shipment ©
Magezon Builder
Credit Memo ©
SMTP Configuration
PDF Customizer
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PDF Customizer

1. General Settings

The Current Version of the extension is 1.0.0

To enable the extension, select Yes in the Enable PDF Customizer field.

General Settings

Current Version
[store view]

Enable PDF Customizer
[store view]

1.0.0

Yes

2. Order

Configure the general settings for the Order documents in this tab.

Order

Attach pdf to new order email
[store view]

PDF Template

[store view]

Order PDF Name

[store view]

Order List PDF Name

[store view]

Show Custom Print Button
[store view]

Display Print Button in Order Grid

[website]

No

Order

order1_{id}_{Y}-{m}-{d}_{H}{i}-{s}

List_{Y}-{m}-{d}_{H}-{i}-{s}

Custom PDF

Yes

- Attach pdf to new order email: Choose Yes to notify customers of the order through

the email confirmation.

- PDF template: Select from 4 existing templates: Order, Invoice, Shipment & Credit memo
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- Order PDF Name: This field will vary according to the name/ID of each order document
and it’s for single order printing only.
The format is Order name_ID_Year _Month_Date_Hour Minute_Second

Try this following setting and see the result:

e @ = order1_000000012_2020-04-29_01-56-50.pdf |1 page) -

-+ o
Ovl Q | & i { R o | ® Q Searct
Laowre m ipsum dolor sit amet. consectetur adipiscing elit. Ut elit tellus, luems
LU MA nec ullameorper matis, pulvinar dapibus leo.

Apr22 2020, 2:2431 PM

Sold To: Ship To:

Mic hael Can Ml heswe ] Clasn

MAGEZON MAGELON

Lang Ha Lang Ha

Ha Moi. [0 Ha Mo 10000

Ve tam W ietmam

T: (92345678 T: 22345678

Payment Method: Shipping Information:

Check ! Money onder Flat Rae - Fined

{ Total Shipping Charges 355 00)

Disage Mame Sku Price ity Tax Tuotal
‘ Fusion Backpack 24-MBO2 5000 o D00 $295.00
Hero Hoodie
‘ Sime: § MHOT7- 8- Green 5400 0 00 $216.00
Color: Green
ﬂ Life Long Fitness I'V 240-LVOS Sl4.00 0 000 S42.00
ﬂ Push It Messenger Bag 24-WB4 500 0 W0 $90.00
Subaotal 643 00
rder PDF i
Order POFName | ordert_{id}_{Y}-{m}-{d}._{H}-(i}-4s) Discount 5128 60
Shipping & Handling 5500

Grand Total $569.40
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- Order List PDF Name: This field will vary according to the name of order documents
when you print in mass.

The format is Order list name_Year_Month_Date Hour Minute_Second

Try this setting:
AL =/ List_2020-04-29_02-13-26.pdf (page 1 of 12)
Ovja @jf ® Q
== T
O Luma
Order List PDF Name ; ;
| D oreme | List_{YHm)-{d}_(H}-{}-s}
o ORDER #000000001
Mar 31,2020, 1:40:31 PM
= Sold To: Ship To:
Veronica Costello Veronica Costello
6146 Honey Bluff Parkway 6146 Honey Bluff Parkway
Calder, Michigan, 49628-7978 Calder, Michigan, 49628-7978
2 United States United States
T: (555)229-3326 T: (555) 229-3326
- Payment Method: Shipping Information:
‘ Check / Money order Flat Rate - Fixed

(Total Shipping Charges $5.00)
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- Show Custom Print Button: Decide to show the Print Button in the Backend Order View

or Customer View.

Show Custom Print Button Custom PDF
[store view]

#000000012 Backend) Q D L ewemne
& Back Send Email Reorder Print PDF Order
ORDER VIEW Order & Account Information

. Order # 000000012 (The orde Order # 000000011 COMPLETE

email was sent)

Invoices Order Date April 22, 2020 Erontend

Order Status Reorder Print PDF Order
Credit Memos

Purchased From

Items Ordered Invoices Order Shipments Refunds
Shipments
Placed from P Product Name SKu Price Qty Subtotal
Comments History
Push It Messenger Bag 24-WB04 $45.00 Ordered: 1 $45.00
Shipped: 1
Refunded: 1
Radiant Tee Ws12-L-Blue $22.00 Ordered: 1 $22.00
) Shipped: 1
size Refunded: 1
L
Color
Blue

- Display Print Button in Order Grid: Decide to display the Print Button for Orders in the

Grid interface or not.

Display Print Button in Order Grid

Y v
[website] €s
Orders
Search by keyword Q Y Filtg © DefautView v | £F Columns v | &, Export v
Actions : 12 records found 20 ¥ | perpage < 1 of 1 >

Unhold

Purchase Date 1 | BilltoName | Shigto Name | CrandTotal Eoand ot Status Signiyd Guarantee

(Base) (Purchased) Decision

Print Invoices

Website Apr 22,2020 2:24:31 Micl a0 Michael Cao $569.40 $569.40 Complete View

Print Packing Slips in Website BM

Default Store

Print Shipping La
lebsite pr 22,2020 2:21:02 Veronica Veronica $210.32 $210.32 Complete View
Nebsitg, M Costello Costello

Print PDF Orders j:ser

‘Vebsite Apr 21,2020 9:56:40 Bao Cao Bao Cao $50.00 $50.00 Pending View

Print PDF Invoiggrweste

MEfre

Batch Process Apr 20,2020 Michael Cao  Michael Cao  $569.40 $569.40 Complete  View
i 10:02:47 AM

Default Store
View
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3. Invoice

Generally, the configurations in this tab are similar to those in the Order tab.

Invoice

Attach pdf to new invoice email 4
[store view]

PDF Template

i v
[store view] Invoice

Invoice PDF Name
[store view]

invoice_{id}_{Y}-{m}-{d}_{H}-{i}-{s}

Invoice List PDF Name invoices_{Y}-{m}-{d}_{H}-{i}-{s}

[store view]

Show Custom Print ButI_:on Both
[store view]

Display Print Button in Invoice and Order
Grid

[website]

Yes v

- Attach pdf to new invoice email: Choose Yes to enclose invoice(s) to the email
confirmation.

- PDF template: Select from 4 existing templates: Order, Invoice, Shipment & Credit memo
- Invoice PDF Name: This field will vary according to the name/ID of each invoice.

The format: Invoice name_ID_Year _Month_Date_Hour_Minute_Second

- Invoice List PDF Name: This field will vary according to the name of invoice documents
when you print in mass.

The format: Invoice list name_Year_Month_Date_Hour_Minute_Second

- Show Custom Print Button: Decide to show the Print Button in the Invoice View
Interface or not.

- Display Print Button in Invoice & Order Grid: Decide to display the Print Button for

Invoices in the Grid interface or not.
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4. Shipment

All the configurations are the same previous tabs.

Shipment
Attach pdf to new shipment email No -
[store view]
PDF Template Shipment =
[store view]

Shipment PDF Name shipment._{id}_{¥}-{rm}-{d}_{H}-{}-{s}

[store view]

Shipment List PDF Name shipments_{Y}-{m}-{d}_{H}-{i}-{s}

[store view]

Show Custom Print Button

[store view] | Both M

Display Print Button in Shipment and Or-
. Yes v

der Grid

[website]

5. Credit Memo

All the configurations are the same previous tabs.

Credit Memo

Attach pdf to new credit memo email No
[store view]

PDF Template

3 Credit Memo v
[store view]

Creditmemo PDF Name | creditmemo,_{id}_{v}-{m}-{d}_{H}-(}-(s}

Creditmemo List PDF Name : .
[store view] creditmemos_{Y}-{m}-{d}_{H}-{i}-{s}

Show Custom Print Button Both
[store view]

Display Print Button in Creditmo and Or-

der Grid
[website]

Yes &
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ll) PDF Customizer Templates

To manage PDF Templates, navigate Marketing > PDF Templates:

© PDF Customizer Templates - Q 4D A msdvin -
Add New Template
¥ Filters © DefaultView v £ Columns ~
Acticns - 4 records found 20 v | perpage 1 of 1
4 . Credit Memo Select ¥
3 Shipment Select *
2 Invoice Select ¥
1 . Order Select *
Templates w
Settings :
There are 2 ways to Add New Template:
© PDF Customizer Templates » Q M L madmn~
Add New Template Manage Templates
Settings e Add New Template
User Guide Change Log . Y Filters > Default View « £ Columns +
Get Support .
- - 20 . ¥ | per page < 1 of 1
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- From the PDF Customizer Templates interface, you can navigate to the Configuration

interface by clicking on this button:

© PDF Customizer Templates - Q M L i
Add New Template Manage Templates
Settings &P Add New Template
User Glids Change Log Y Filters @ DefaultView v % Columns v
Get Support -

20 - | per page € | 1 of 1

- Filter the Templates by ID, Name, or Status using Filters button.

Y Filters
1D ] MName Status
from v
- Define which column to be visible using this field:
Y Filters > Default View ﬂ Columns a

4 out of 4 visible

lv| ID |v| Name |v| Status

[v| Action

Reset Cancel

11
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- From left to right, we get:

Actions

3,

A 4 records found 20 v  per page < 1 of 1 %
< BE3 D | Name Status ‘ Action
4 Credit Memo Select ¥
3 Shipment Select v
2 Invoice Select ¥
1 Order Select ¥

1) Actions: Apply action (Delete) to the selected template(s)

(1)
(2) Select box: Tick the boxes in the left of each template or elect all if necessary
(3) Per page: Define the number of templates to be displayed per page

(4)

4) Action: Decide to Edit or Delete the selected template

12
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I\V) Builder Interface

1. General

After hitting the Edit/ Add New Template button, the builder interface will appear like

below (We use Order Template as an example):

© Order - Q M A& rodons

Template Name #* | Order

Magezon PDF Builder ~ ©

Advanced ©

- Back: Back to previous working interface
- Delete: Delete the existing template
- Save button: There are 3 choices: Save & New, Save & Duplicate or Save & Close

- Template Name (Required field): Enter the name of the order here

13
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2. PDF Builder section

This section contains 2 tabs: PDF Builder & Preview that allow you to build orders with

drag & drop gestures and preview the result right away.

Magezon PDF Builder ~ @
PDF Builder Preview
O + = = 9 ¢ @ @ I

Hit the Plus button to see what can be added to your header/ footer.

The list of 12 elements supported will be shown like follow:

Add Eemert X

Content Pdf

Paw Text Block Heading 4 Separator » Single Image =y Site Logo
Place content —_— ! f

.+ a!;i(:{;‘_i’:‘u“hﬂ A block of text with H Create stylish title S5 Horizontal separator (gl Single image with S5 Display current logo
e =t o WYSIWYG editor headings line imati of your store

animation

row

Field Items Totals Bar Code a QR Code Link

- Row, Text Block, Heading, Separator are the core elements that are described
carefully in this guide.
- Single Image, Site Logo are Magezon Page Builder’s elements and can be learnt

through its guide (Page 27 & 128).

14
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3. Advanced section

This section allows you to set up the printing layout with the following fields supported:

Orientation, Page Size, Show Page Number, Margin Top, Margin Right, Margin

Bottom, Margin Left.

Set the layout to be Portrait with A4 in size, No page number & Default margin:

0 LUMA e

Portrait
i Mar 31, 20020, 1-40:30 PM
Ad size 00, 140
Sald To:
Veromica Costelk
&146 Floney BT Parkway 3
Culder, Michigar, $9628-797% s
Lnted Statew
T 8512793308
Payment Method: Shipping Information:
C k' Maooes osder Flat Rave - Foud
Totsl Shipping Charges §5.00)
Image Name Skn Frice oy Tax
Iris Warkast Tap
Siaz XS WSI-XS-Ree 1290 o 2
Color Red
Scheceal
Taa
Skippry & Hazdling
Cirared Total
Advanced
Set up.the printing
" \.n.n.n_\/‘\.....-.f“-.-...-.-_u\_’
Orientation Portrait v
Page Size Ad -
Show Page Number No
Margin Top
Margin Right

Margin Bottom

Margin Left

Now, come to our specific elements.

15



¢))Magezon

PDF Customizer

V) Specific Elements

1. Field

Let’s try the following configuration and see the result in the front:

Field &

General

Design Options

ORDER

Name
Mar 31, 2020, 1:40
Sold To: Color Font Size
Veronica Costello
6146 Honey Bluff |:| | #23H09 ‘ | 51
Calder, Michigan, «
United States
T:(sssne315  Font Weight Line Height Alignment
Payment M, | 300 ‘ ‘ 200 ‘ ‘ Center - ‘
Check / Money ord
Image Name Sku Frice Oty Tax Total
Iris Workout Top
‘ Sime: X8 WE03-X8-Red 529.00 ] 239 £29.00
Colar: Fed
Subtozal £29.00
Tax §2.10
Shipging & Handling £5.00
Grand Tazal $36.39
PR Field Name

displayed

16
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2. ltems

Add products, selling items into the order list with this variable element.

Image Name Sku Price Qty Total
Iris Workout Top
Size: XS WS03-XS-Red $29.00 0 £29.00
Color: Red

Image,size,configured
—— A eI e

ltems &

General Columns Design Options

General table settings

e T
Title
| Image | Items ’
Content [<ELEEI Columns  Design Options

<img src="{{var item.thumbnail}}" width="100" height="100" />

) Table
£ Border Width Border Style Border Color

| -] | | soia (o] (] rossess
@ Heading
Font Size Font Weight Line Height
Padding Text Calor Background Color
| ‘ ||:|H T | E| #d64e53
Border Width Border Style Border Color

| e BN

Height
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3. Totals

Add Totals that automatically calculate the summary of the orders. Freely configure the look

of the Totals table.

@ Label
Width Padding
Font Size Font Weight ® Table
‘ | ‘ 300 ‘ Border Width Border Style Border Color
Solid - . #535353
0Odd Row Color 0Odd Row Background Color
E| #000000 | D| #f0c0c2 \ ‘
Even Row Color Even Row Background Color \
E| #000000 | D| #d2e6c9
rice Qty Tax Total

Iris Workout Top

Size: XS

Color: Red Border,color,

5 gddh Ev:n rlow set:
ackground colorset:
@ value --—-ﬁq’u-—-'\n-—-—r\.n-’ \
Subtotal $29.00
Width Padding
| ‘ | | Tax $2.39
Shipping & Handling 5.00
Font Size Font Weight pping $
300
| N / Grand Total ~ $36.39
4

Odd Row Color

Odd Row Background Color

Ii“ #000000

‘ ||:|H #f0c0c2 / |

Even Row Color

Even Row Backgroupd Color

Ii“ #000000

4 | Grand Total

[ ]| #azescs Label coler,set:
@ Grand Total
Font Size Fpnt Weight Line Height
‘ 25 | VSUU | ‘ 30 ‘
Label Color Label Background Color
mew N |
Value Color Value Background Color

E| #3170b9

18
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4. Bar Code

Try setting the Bar Code with Size 1:

Q Luma LT _—c—s

ORDER #000000001

Mar 31, 2020, 1:40:31 PM Bar COde i —_ X
Sold To: [UEM  Design Options

Weronica Costello

6146 Honey Bluff Parkway

Calder, Michigan, 49628-7978 Bar Code Data

United States

T: (5551 229-3326 {{var order.increment_id}}

Size

Or Size 2, 3, etc. Customize the size the way you want:

e WA

ORDER #000000001 Size 2,

Mar 31, 2020, 1:40:31 PM

Bar Code &

Sold To:

Veronica Costello

6146 Honey Bluff Parkway
Calder, Michigan, 49628-7978
United States

T: (555) 229-3326 Bar Code Data

[ELEl:II  Design Options

{{var order.increment_id}}

Size

19
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5. QR Code

Similar to the Bar Code configuration, set up your QR Code to fit the order most.

You can set its size to be 1:

©Q Luma

ORDER #000000001

Mar 31, 2020, 1:40:31 PM

Sold To:

Veronica Costello

6146 Honey Bluff Parkway
Calder, Michigan, 49628-7978
United States

T: (555) 229-3326

QR Code ¢

[LLTIEI  Design Options

QR Code Data

{{var order.increment_id}} \
4
Size \

E \ |

Specifies the size of the barcode.

Or even 0,5 if you think it makes sense:

O Luma

ORDER #000000001

Mar 31, 2020, 1:40:31 PM

Sold To:

Veronica Costello

6146 Honey Bluff Parkway
Calder, Michigan, 49628-7978
United States

T: (555) 229-3326

QR Code ¢

General [VES-GRel

QR Code Data

{{var order.increment_id}} \
¥
Size \

o \ |

Specifies the size of the barcode.

20
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6. Link

Set up the Link element to place an anchor text into the order that leads customers to the

desired site. Easily set up the Link with 4 types supported:
- Category Link

- Product Link

- Page Link

- Custom URL

Image Name Sku Price Qty Tax Total

Iris Workout Top
Size: XS WS03-XS-Red $29.00 0 $2.39 $29.00

Color: Red

Check your cart on site

General Design Options

Text

‘ Check your cart on site

Link

Select Url Custom Url: https://www.magezon.com/magezon-page-builder-for-

magento-2.html Title:

Color Font Size
E‘ #007dbd ‘ ‘ 15

Font Weight Text Underline
‘ 300 ‘ @)

21
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VI) Support

If you have any questions or need any support, feel free to contact us. We will get back to

you within 24 hours since you submit your support request.

e Submit Contact Us form.
e Email us at support@magezon.com.
e Submit a ticket.

e Contact us through Skype: support@magezon.com.

22
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